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Welcome to the Alaska Exotic Plant Management Team! This document will guide you through 
this summer’s field season, including collecting data using Trimble GPS units and a customized 
Data Dictionary, data management, collecting specimens, taking photographs, and more.  Since 
the same protocol is used throughout the Alaska Region of the NPS, it is intended to maintain 
high standards of quality in data and consistency among observers.  If you have any questions 
about what is written here, contact data manager Whitney Rapp (907-697-2603, 
Whitney_Rapp@nps.gov). 
 
The protocol itself is a GPS-based method to map exotic plant infestations and uninfested areas 
and collect relevant information about them.  The data will become part of a database that spans 
multiple years from across the Alaska Region of the NPS.  It will also be incorporated into a 
statewide database that has been developed to track exotic plant distributions across 
jurisdictional boundaries. 
 

Most Importantly 
 
From a national performance standpoint, our work is assessed by 1) the number of acres treated 
and 2) the number of acres controlled (infestation documented eradicated after previous year(s) 
efforts).  We need to ensure that all work gets documented so the year end values reflect our 
excellent work. 

 Number of acres treated – any control effort of EPMT team, volunteers, other park 
employees, etc. needs to be mapped.  If mapping is not feasible, we can work on 
digitizing areas from sketches, descriptions, etc, but you need to relay all the relevant 
information to Whitney Rapp 

 Number of acres controlled – it is critical that previous infestations are revisited and 
remapped.  If the infestation is gone (yeah!), map the location where it once was and 
indicate what taxon was there and phenology “not_detected.”  At the end of season, 
Whitney will inquire whether you perceive these infestations to be eradicated. 

 
Additionally, some other key points for this year are: 

 Future use of herbicides will be determined by past mapping efforts.  The plan needs to 
show that alternative control methods have not been viable over a 3-5 year period.  This 
means we need data over 3-5 consecutive.  Treatments to priority infestations and 
subsequent mapping annually is essential. 

 At least two “money” shot photos are needed from every park this year.  These shots 
should include people (arrowheads, uniforms, etc are always good), action, invasive 
plants, and great backgrounds.  Staging the photo is acceptable (glacier background, 
wildlife, mountains, etc).  We want cover photos! 

 
There are many other integral components to our program that will be discussed throughout the 
protocol. 

mailto:Whitney_Rapp@nps.gov
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Starting the Season 
Establish Park Priorities for Season 
 

 What are you going to do this summer?   
 Where are you going to go?   
 What areas need to be revisited?   
 What new areas need to be inventoried?   
 What are the control priorities? 

 
First, read all the annual field reports for your park whether you are returning or new to the 
program.  The insights from previous years will be invaluable to establishing priorities for this 
season.  Consult with Whitney Rapp for a regional perspective and your park supervisor and/or 
resource division for a local perspective.  Remember that plant phenology will dictate some of 
your work.  In other cases, travel logistics may limit access to areas of the park.  Undoubtedly, 
there will always be more that could have been done, but with a solid set of priorities, you will 
accomplish a significant amount this summer. 
 
To aid in developing priorities, all previous data was merged to delineate the maximum mapped 
area of different infestations over the course of the EPMT program.  This data is available for 
GIS, as well as in summary tables sorted by different criteria (park, location, species, ranking, 
etc).  This information will help develop real goals.  For instance, if there are 250 infestations of 
species A (ranking 52) covering 13 acres and 3 infestations of species B (ranking 71) covering 
0.009 acres, it should become evident that the priority is species B since it is higher ranked, less 
abundant, and covers a much smaller area. 
 
As a regionwide priority, map all species with a ranking greater than 50 (Table 1) at a higher 
precision than you might otherwise since we need to have more precise information on 
distribution and extent of infestations for planning alternative, non-manual treatments. 
 
Table 1 – Species of greatest threat to Alaska.  Species in bold are already known to occur in or near 
Alaskan National Park Units.  All of the following species should be mapped and treated with the highest 
level of precision.  Ranking from Invasiveness Ranking System for Non-Native Plants of Alaska. 
Scientific Name(s) Common Name(s) Rank

Myriophyllum spicatum Eurasian watermilfoil 90 

Polygonym sachalinense, Fallopia sachalinensis, 
P.× bohemicum [cuspidatum x sachalinense], F. 
x bohemica, P. cuspidatum, F. japonica 

giant knotweed, Bohemian knotweed, 
Japanese knotweed 87 

Centaurea biebersteinii spotted knapweed  86 
Spartina alterniflora, S. anglica, S. densiflora, S. 
Patens cordgrass complex 86 

Euphorbia esula leafy spurge 84 
Lythrum salicaria, L. virgatum purple loosestrife, spike loostrife  84 
Phalaris arundinacea reed canarygrass, canarygrass  83 
Impatiens glandulifera ornamental jewelweed 82 

http://akweeds.uaa.alaska.edu/akweeds_ranking_page.htm
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Scientific Name(s) Common Name(s) Rank
Heracleum mantegazzianum giant hogweed 81 
Melilotus alba white sweetclover  81 
Hydrilla verticillata waterthyme 80 
Nymphaea odorata ssp. odorata white waterlilly  80 
Hieracium aurantiacum and Hieracium 
caespitosum 

orange hawksweed, devil's paintbrush 
& meadow hawkweed  79 

Bromus tectorum cheatgrass 78 
Rubus discolor Himalyan blackberry 77 
Cirsium arvense Canada thistle  76 
Prunus padus European bird cherry  74 
Sonchus arvensis perennial sowthistle 74 
Vicia cracca bird vetch, cow vetch, tufted vetch  73 
Lepidium latifolium broadleaved pepperweed 71 
Alliara petiolata garlic mustard 70 
Brachypodium sylvaticum false slender brome 70 
Cytisus scoparius English broom, Scotch broom 69 
Linaria vulgaris yellow toadflax, butter and eggs 69 
Melilotus officinalis yellow sweetclover 69 
Caragana arborescens Siberian pea shrub  66 
Lonicera tatarica Tatarian/bush honeysuckle 66 
Campanula rapunculoides creeping bellflower  64 
Medicago sativa ssp. falcata yellow alfalfa 64 
Hordeum jubatum foxtail barley  63 
Senecio jacobaea ragwort, stinking willie  63 
Bromus inermis ssp. inermis smooth brome 62 
Alnus glutinosa European alder 61 

Cardus acanthoides, C. nutans, C. pycnocephalus, 
C. tenuiflorus 

spiny plumeless thistle, nodding 
plumeless thistle, Italian plumeless thistle, 
winged plumeless thistle, 

61 

Cirsium vulgare bull thistle, common thistle  61 
Leucanthemum vulgare oxeye daisy, white daisy  61 
Hordeum murinum ssp. leporinum leporinum barley, lepor barley  60 
Elymus repens quackgrass, couchgrass, dog grass  59 
Medicago sativa ssp. sativa Alfalfa 59 
Sorbus aucuparia European mountain ash, rowan  59 
Trifolium repens white clover, ladino clover  59 
Linaria dalmatica dalmation toadflax 58 
Taraxacum officinale common dandelion 58 
Gypsophila paniculata baby's breath  57 
Potentilla recta sulfur cinquefoil 57 
Tanacetum vulgare common tansy, garden tansy  57 
Trifolium hybridum alsike clover  57 
Convulvulus arvensis field bindweed, morning glory  56 
Lupinus polyphyllus bigleaf lupine 55 
Phleum pratense common timothy  54 
Crepis tectorum narrow-leaf hawk's beard  54 
Ranunculus repens, Ranunculis acris creeping buttercup and tall buttercup  54 
Stellaria media at sea bird colonies  common chickweed  54 
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Scientific Name(s) Common Name(s) Rank
Dactylis glomerata orchardgrass 53 
Trifolium pratense red clover  53 
Vicia villosa winter vetch  53 
Zostera japonica dwarf eelgrass 53 
Hypericum perforatum  St. Johnswort  52 
Poa pratensis ssp. pratensis, P. pratensis ssp. 
irrigata, P. trivalis 

Kentucky bluegrass, spreading 
bluegrass and rough bluegrass  52 

Verbascum thapsus common mullein  52 
Digitalis purpurea purple foxglove 51 
Hieracium umbellatum narrowleaf hawkweed 51 
Rumex acetosella sheep sorrel 51 
Fallopia convolvulus (Polygonum convolvulus)  black bindweed  50 
Tagopogon dubius yellow salsify, goat's bear  50 

 

General File Management 
 
In an effort to organize data that works well for each team and future users of the files, a 
suggested file structure is described. 
 

1. In collaboration with your supervisor or IT staff, identify the appropriate place to 
store your data at your park that is accessible by you, secure, and routinely backed up.  
This may be on your local machine (C:\) or on a network drive.  It is best to co-locate 
data for 2009 with previous data. 

2. Relocate the past year(s) folder or create a folder (such as EPMT_(park code)) in this 
location that will contain ALL of your data, documents, etc.  Within this folder, tiers 
of subfolders can be created.   

3. The suggested file structure is depicted in Fig. 1 with each balloon representing a 
folder.  This is definitely not exhaustive of the possibilities, but it is a framework to 
organize files, is adaptable for many years, and will be useful for others. 

4. In the root folder, create an index document (index.doc or Project_Organizer.doc) in 
Word that directs people to the various files within the folders.  Using hyperlinks will 
further facilitate others to find relevant information quickly. 

5. At the end of the season, make 2 copies of the entire folder to CD or DVD.  Label the 
CD/DVD with EPMT, Park Code, and year.  Send one copy to the regional office and 
store another at your park. 

 
 

*** All GPS data must be edited and uploaded to the regional drive by the end of every pay 
period (every 2 weeks).  This will ensure that the data is being processed correctly and timely 
on your part and that Whitney can process it into the national and statewide databases and make 
the data available for your use. 
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EPMT_park 

Data 
 

Documents 
 

Protocol 
Where this document will go 

Other Folders 
e.g. Software 

GIS 
Use for creating maps. 

GPS 
Use for data from Trimble GPS 

Collections 
Collections spreadsheet 

Images 
Digital photographs 

Reports Presentations 

Literature 

2009 
GPS data from 2009 

Educational Materials 

2009 
Images from 2009 

2009 
GIS maps from 2009 

Index.doc or 
Project_Organizer.doc 

Figure 1 – Suggested file management structure for storing electronic files at your park.  Please 
remember to copy all files to regional drive and/or to CD/DVD at end of season. 
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Setting up Trimble GPS Units 
 
This protocol does not provide instructions on the operation of Trimble GPS units.  The Alaska 
EPMT will be using primarily Trimble GeoXT receivers and TerraSync 3.30 and Pathfinder 
Office 4.10 software.  More detailed protocols on GPS operation should be addressed through 
Trimble training provided by Joel Cusick (907-644-3549).  Reviewing his training binder may be 
helpful.  In addition, many GPS solutions are posted on the regional GPS web pages - 
http://inpakroms03web/rgr/gps/tips.htm and 
http://inpakroms03web/rgr/akgis/index.cfm?action=dsp&topic=gps&item=gps.  Finally, these 
TerraSync guides provide good information – Getting Started Guide. 
 
With that, let’s jump right into the EPMT GPS protocol that lies at the heart of our data 
collection using the Trimble GPS.   
 

GPS Software 
 
 TerraSync (TS) is the software that operates on your GPS.  The current version v3.30 is 

available from Trimble.  You will need your TerraSync serial number to upgrade.  To run 
this version, you must also upgrade to Pathfinder Office v4.10.   

 
 Pathfinder Office (PFO) is the software that operates on your computer to process your GPS 

data.  The current version v4.10 is available from Trimble.  You will need your Pathfinder 
Office installation code (serial number) to upgrade.   

 
 ActiveSync is the software that enables your computer to communicate with your GPS.  For 

computers running Windows XP, the current version 4.5 is available online. 
 
Let Whitney know if you are working with older software versions since settings may be 
different!  It is best to uninstall previous versions and install new versions.  Depending on your 
user settings for computer use, you may require an IT specialist to facilitate the software 
installations. 

 

GPS Housekeeping at Start of Season 
 
What legacy data will you be carrying around with you this season?  None, if you do the proper 
housekeeping!  This will speed up your GPS unit and ensure plenty of storage space. 

1. Using PFO, download all the rover files to a backup folder and notify your park’s GIS 
personnel or past users of file locations. 

WARNING:  If you have a GeoXT 2003 (two buttons on front), these should only be 
connected to a computer using a USB hub.  There have been many cases of power surges 
frying the computers!  The hubs buffer this surge. 

http://inpakroms03web/rgr/gps/tips.htm
http://inpakroms03web/rgr/akgis/index.cfm?action=dsp&topic=gps&item=gps
http://www.trimble.com/terrasync_ts.asp?Nav=Collection-4576
http://www.trimble.com/pathfinderoffice_ts.asp?Nav=Collection-4552
http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
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2. In Windows Explorer with your unit connected to the computer, select the Mobile Device 
from My Computer. 

 

 
3. Navigate to \Disk\My Documents\TerraSync (most likely location), copy all files to a 

backup folder on your computer, then delete them from your GPS.  Look into other 
folders as well. 

4. Backup your GPS unit (Start>Backup Now). 
5. In TS on the GPS, use the File Manager (Data>File Manager) to delete all previous data 

that is no longer needed.  For example, old rover files, data dictionaries, backgrounds, 
etc.  Some background files may still be useable if made for a similar area or purpose. 

6. Backup your GPS again. 
 

GPS Transfers 
 
To have the GPS communicate with the computer, you must have Microsoft ActiveSync 
installed on the computer.  Once ActiveSync is installed, the GPS cradle is connected to the 
computer, and the GPS (already on) is placed in the cradle, the GPS should connect to the 
computer.  If you have problems, try restarting the computer, reconnecting the GPS, and 
reconnecting the cradle.  If you still have problems, try contacting one of us. 
 
 



 

AK EPMT Protocol 2009  -  9 

GPS Settings 
 
Files must be initially transferred to the Trimble unit using the Data Transfer utility in Pathfinder 
Office.  They are located in the GPS_Settings folder in 2009_OUTGOING.  Never transfer 
Trimble associated files using Explorer or any other means besides the Data Transfer utility.   
 
 
 
Transfer the following files to the GPS: 

1. Configuration file (GeoXT2003Summer_09_TerraSync.tcf or 
GeoXHwithZephyrSummer_09_TerraSync.tcf) following the instructions in the 
associated word file.  If you get an error on the GPS, you are likely not running the 
current version of TerraSync.  For GPS receivers not using TerraSync, contact us. 

2. Data Dictionary file (09_AKEPMT_master.ddf) after you have arranged the fields for 
your own convenience using the Data Dictionary editor utility in Pathfinder Office. 
a. Do not remove or add attribute values or data fields. 
b. Arrange the order of attribute values using the up and down arrows so that the 

ones you use most commonly are at the top of each list.  For example, your 
initials and your park’s locations. 

c. Set the values that you use for most records as defaults if desired.  
d. Any field you alter as described above must be altered in all feature classes 

(Pnt2Buf, Line2Buf, Poly, etc).  An easy way to do this is by copying the data 
field you’ve altered (ctrl+c), then pasting it into the other feature classes (ctrl+v), 
and then deleting the duplicate unaltered field it replaces (Delete key).  

e. Save the modified file with your initials (e.g., 09_AKEPMT_WSR.ddf). 
f. Load this modified data dictionary onto your GPS unit.  If possible, only use one 

data dictionary during the season. 
3. Data files ([park]_[species code].imp) of data from previous years.  In 2009, all past 

data was merged to show the perimeter of the greatest extent of the infestation 
mapped in the past.  This reduces file size and eliminates cluttered overlapping 
polygons. 

 
Set time zone: 

1. Go to the “Start” menu of the Trimble unit 
2. Tap on “Settings”  
3. On the “System” tab, tap on “Clock” 
4. Verify that the time zone is set to “GMT-9 Alaska” and tap OK. 
5. Is the time right after the unit has been outside and received satellite information? 
6. Due to the recent changes in Daylight Savings Time, Mobile 2003 units and newer 

have patches to correct for the time of year shifts.  See Joel Cusick’s bulletin on 
updating time.  

 
To standardize our Trimble units for data collection, we are using a configuration file that sets 
the most important GPS settings to predetermined values.  

1. Open up TerraSync on the unit (tap F1)  
2. Select “Setup” from the main menu.   

http://165.83.62.205/rgr/akgis/documents/GPS/UpdatingGPSDevicesToLocalTime.pdf
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3. Below the “Current Configuration:” box, tap on the box labeled “Change”  
4. Select “GeoXT2003Summer_08_TerraSync” or otherwise from the menu and tap on 

“Load” 
5. Tap on the “Logging Settings” box from the “Setup” screen. 
6. By default, the antenna height is 1.5m.  Click on the wrench icon and change the 

height to your own chest height.  You should hold the GPS at this height to collect 
data.  You can enter a height in feet (enter a value “4.25 ft”) and it will automatically 
convert to meters (“1.295 m”). 

7. Still in “Logging Settings,” change the “Filename Prefix” (default ‘R’) to the first 
letter of your last name.  If multiple users use the same GPS, assign individual letters 
to each unit (such as A and B) and do not modify. 

 

GPS Background Images 
 
Having a background file display on your GPS or in PFO can be very helpful to navigate to a 
new location or verify that data is correctly recorded.  To get a background image to display, you 
must create a jpg file in ArcGIS, transfer the file, and verify the coordinate systems of the GPS. 
 

1. Make a map in ArcGIS.  Some helpful information may include a background photo, 
USGS topographic maps, NOAA charts, previous data, park boundaries, trails, etc.   

2. Record what the map coordinate system is by double clicking on the “Layers” icon in 
the right navigation window.  Look at the “Coordinate System” tab.  The map should 
be in a projected coordinate system (Alaska_Albers_Equal_Area_Conic or 
NAD_1983_UTM_Zone_8N).  Be aware that regional data was converted from 
NAD27 to NAD83 in 2006. 

3. Once the data is arranged as you would like it and the screen has the map extent that 
you want (zoom in and out to export what is visible in the window), select “Export 
Map” from the “File” menu. 

4. Experiment with different resolutions and qualities.  Having a background image will 
slow down GPS map drawing, so you need to balance between speed and image 
quality.  The higher the resolution and quality, the slower the image will redraw.  
Since map drawing is affected by how large the map is, you may want to create 
several smaller maps for different study areas so the GPS has less to redraw at any 
one time. 

5. Check the “Write World File” option and save the map.  Adding the resolution to the 
end of the file name will help remind you of what files are larger and smaller. 

6. Open PFO (testing the image in PFO will save you much anguish with the GPS). 
7. Select “Coordinate System” in the “Options” window.  Define the coordinate system 

to match the exported map.  This is only changing how the data is displayed, not how 
it is collected or saved.  See Table 2 for the correct settings based on the projection of 
your image.  If these options aren’t showing up, you probably do not have the most 
current version of coordinate system software.  To fix, close PFO.  Go to C:\Program 
Files\Common Files\Trimble\GeoData and backup current.csd (make a copy and 
paste in same folder).  Then delete the file current.psd.  Re-launch PFO, and it should 
rebuild the file and provide the needed options. 
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8. Make sure “Coordinate Units” is in meters and hit “OK.” 
9. Load the background in PFO by selecting “Background” from the “File” menu.  Click 

“Add” and navigate to the image. 
10. Change the coordinate system to match the coordinates you just established for PFO. 
11. Select “OK” and the image should load. 
12. Verify the image is correctly positioned by opening a data file (.ssf or .cor) and verify 

that the features align with the image. 
13. Connect your GPS to the computer. 
14. Using PFO, transfer the image to the GPS using the “Send” tab and “Add”ing a 

“Background.” 
15. On the GPS, go to “Setup” in TerraSync. 
16. Change the “Coordinate System” to match those defined in PFO (Table 2).   
17. Go to “Map” and under “Layers” select “Background File.”  Choose the correct file. 
18. Under “Layers”, make sure the “Background” option is checked.  Image should 

display and you won’t get an error if all the coordinate systems were properly 
assigned. 

 

Collecting GPS Data 
 
When you walk up to an infestation of exotic plants, the first question to ask yourself is: can this 
patch be best represented as a point, a line, or a polygon?  Because all patches take up 2-
dimensional space, they are all actually polygons.  Using GPS units to map exact polygons takes 
more time, so we sometimes save time by mapping them as points or lines and using a “buffer 
distance” that the plants extend from the point or line.   
 
In addition to mapping infestations, you should map areas with no exotic species to document 
that you looked in the area and aid in future monitoring.  This is critical baseline data since the 
absence of exotics is as valuable as the presence of exotics.  Use the “none” or “0” option for the 
data fields to record the absence of exotic plants. 
 

Points 
 

 Use points on a very small patch of plants in a circular shape.  Use a “buffer distance” 
representing the radius of the circle to capture the size of the patch. 

Lines 
 

 Use a line to represent a long string of plants along a roadside, shoreline, or similar edge.  
Apply a “buffer distance” equal to half the width of the linear patch and walk the midline 
of the patch. 
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Table 2 – Coordinate settings required for Albers or UTM (KLGO, GLBA, SITK) for use in ArcGIS, 
Pathfinder Office, and TerraSync. 

 Albers (All other AK parks) UTM (KLGO, GLBA, and SITK) 
ArcGIS 

Coordinate 
System 

Alaska_Albers_Equal_Area_Conic (using NAD83)

 

NAD_1983_UTM_Zone_8N 

 
Pathfinder 

Office 
Coordinate 

System 

TerraSync 
Coordinate 

System 

System: US Continental 
Zone: Alaska Albers83 (CORS 96) 

Datum: NAD 1983 (Conus) CORS96 
Altitude Reference: Mean Sea Level (MSL) 

Altitude Units: Meters 
Geoid Model: Other 

Geoid: DMA 10x10 (Global) 
Coordinate Units: Meters 

Display USNG: Off 

System: UTM 
Zone: 8 North 

Datum: NAD 1983 (Conus) CORS96 
Altitude Reference: Mean Sea Level (MSL) 

Altitude Units: Meters 
Geoid Model: Other 

Geoid: DMA 10x10 (Global) 
Coordinate Units: Meters 

Display USNG: Off 
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Polygons 
 

 Actual polygons are best used to map large or irregular shapes that are not well-
represented by points or lines.  They should be used to map most infestations of species 
ranked greater that 50 by the Alaska Natural Heritage Program, in order to provide 
sufficient precision to be able to document short-term changes in patch shape. 

 

 
Figure 2 – Green squares represent invasive plant species.  The three feature types for mapping 
infestations are displayed in red with blue buffers where applicable. 
 

Data Dictionary Fields 
 
The standardized data dictionary has fields that help systematically describe plant populations 
throughout the state. 
 
Table 3 – Description of data dictionary fields used to map exotic plant infestations (Pnt2Buf, Line2Buf, 
and Poly). 
Location_Name This is the general area where the activity takes place with several possible in 

and around each park unit.  For a description of each area, see the LocationID 
table below.  Note that a single LocationID must either be inside or outside of 
the park boundary; pay careful attention to this in choosing the appropriate one.  
You should certainly arrange these in the order of your most common usage. 

Disturbance_Type Because most of Alaska’s exotic plants grow only on disturbed sites, we are 
tracking what disturbance types are being invaded by what species in NPS units.  
The options are listed in the Disturbance Type table below.  The most frequently 
applicable type is fill importation, which includes roadsides and construction 
sites.   

Site_Description The location description is an opportunity for you to delineate in words the exact 
location, as well as any information about that location that might be important.  
The first provision should enable someone who looks at a table of your data to 
understand where within the LocationID the work took place without having to 
use GIS.  Take the time while editing to be complete.  The second provision 

Polygon Point with 
Buffer 

Line with 
Buffer 
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should note if there is special significance in the location, such as remoteness, 
proximity to a stream or river, or potential to be easily spread into other areas.   

Buffer_Distance_M This is the buffer distance in meters that will be used to convert points and lines 
into polygons.  If you imagine the shape you will be creating, the buffer distance 
should extend the point or line to the boundary of the infestation at its maximum 
distance from the center point or line.  The buffer distance will therefore be half 
the width of a linear shape or the radius of a circle around a point.  The GPS unit 
can also offset a line so that you may walk the edge of a linear infestation, offset 
the line to the middle of the infestation, and assign a buffer distance according to 
its width.  The buffer for uninfested roads and trails should generally be 5 
meters, measured from the centerline of a trail or the barren edge of a road.   

Taxon This is the dominant exotic plant species of a particular infestation.  All species 
that have been reported from Alaska NPS units are on this list.  If the species of 
concern does not appear on the list or you are uncertain of its identity, enter 
“Other” and note the species or uncertainty in the Comments field.  If the 
mapped area is free of exotic plants, enter “None.”  Remember to record species 
ranked greater than 50 precisely rather than as part of another species’ 
infestation. 

Phenology The dominant phenology at the time of the exotic species is especially important 
for control timing and future planning.  “rosette” is for plants that are still young 
and have not reached their full size.  “no_flower” is for plants that are full size, 
but they are not currently flowering or producing seed.  “full_flower” are plants 
that are currently flowering.  “in_seed”  are plants that are currently producing 
seed.  “stand_dead” are plants that are standing dead.  If there are no exotics 
present, enter “none”.  You can clarify in the comments if the species has 
multiple phenologies.  If you are monitoring a location for a species and it is 
not redetected, put the name of the species being searched for in Taxon and 
select “not_detected” in phenology.  This will allow us to better track 
eradications.  

%_Cover The cover class percentage of the dominant exotic species is a critical measure of 
an infestation’s density.  Imagine yourself suspended directly above the polygon 
you are mapping, including the buffer applied to points and lines.  The value you 
enter is the percentage of the entire area that is covered from this angle by the 
material of the exotic species, with options of 1, 5, 10, 20, 30, 40, 50, 60, 70, 80, 
90, 95, and 100.  This is much easier to do with small areas than with large ones, 
so start by practicing with small patches and be conservative with your estimates 
(i.e., do not overestimate).  Note that there is a correlation between this value and 
the buffer distance or size of a polygon: as the buffer distance increases for a 
particular group of plants, their percent cover of the total area decreases.  Do not 
worry if most of the time the value entered is 1, for this is common with the non-
woody, dispersed plant populations we are dealing with.  It is most important to 
record accurately the extent and density of an infestation. 

Stem_Count This is a stem count of the dominant exotic species.  Only enter a value when 
you are certain that you can provide a relatively accurate count of individual 
plants.  If the action is a control event, this is much easier since each person can 
count the number of plants he or she controls.  If the action is not a control event, 
do not record a value over 100 unless you have carefully counted the plants.  
You will find during control that there are almost always more plants than you 
saw at first.  If you don’t count the plants, leave the field with the default, -9, 
which indicates no plants counted.  A zero should only be used if there are no 
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plants. 
Action “Inventory” is the first documentation of a particular infestation, whereas 

“Monitor” is a follow-up visit to a previously inventoried site from this year or 
previous years.  “Treatment” is the first control effort for a particular infestation 
and “Retreatment” applies to any subsequent control efforts in either the same or 
successive years.  “Manual” involves pulling or digging.  “Mechanical” involves 
actions like mowing, weed-whacking, chain-sawing, etc.  “Chemical” involves 
the use of herbicides.   

%_Treated Percentage of area treated – 0, 1-25%, 26-50%, 51-75%, 76-95%, 96-100%.  
Make notes in comment field what was/wasn’t treated.  For example, removed 
all flowering plants or many seedlings left. 

Control_pers_hrs Actual person hours spent doing control work for all people involved. 
CntrlEffrt For planning and evaluation, it is helpful to have a relative indicator of the 

control effort required for a particular infestation.  This can be projected if the 
infestation is not controlled or actual if it is.  To standardize, “low” refers to an 
infestation that could be manually controlled by one person in less than an hour.  
“Medium” infestations could be controlled by one person in less than an 8-hr. 
day.  “High” infestations would require multiple people or multiple days to 
control. 

Is_Exhaustive If all the exotic plants encountered were recorded, enter “yes.”  If only a subset 
of species are recorded, enter “no.”  In general, you should record all species; 
however, if you are trying to map a particular species very accurately, you may 
want to use this option to ignore other species. 

Comments This is a free-for-all for you to convey anything that seems important about an 
infestation or uninfested area, such as: control might not work for a particular 
reason; species’ identity is uncertain or not listed in the species list; components 
of the native plant community; potential for spread if left untreated; data 
collection is incomplete; where to look if hidden; invading undisturbed plant 
community; apparent source of infestation; similar native species in the same 
area; need for monitoring, etc.  You are free to use shorthand in the field as long 
as you make it intelligible during editing! 

Park_Unit Associated park is the four-letter code for whatever park unit you’re working in, 
which should be set as the default value. 

Is_Inside_Park If the area mapped is located on park land, enter “yes”; if it lies outside of the 
park boundary or on inholdings, enter “no”. 

Recorder_Name These are the initials of the person using the Trimble unit.  Set your initials as the 
default value. 

Team_Name If you are performing the activity in question alone or with help, enter 
“AKEPMT”.  If you are recording the accomplishment of volunteers or SAGA, 
enter “Volunteer”, or of other NPS personnel, enter “Other”. 

2Taxon, 3Taxon… 
 
2Phenology, 
3Phenology… 
 
2%_Cover, 
3%_Cover… 
 
2StemCount, 
3StemCount… 
 

We have provided additional fields for 9 more exotic species other than the 
dominant species at a particular site.  In general, we prefer that you record each 
species individually with its own shape rather than use these additional fields.  
This option is provided to save you time when there is a whole complement of 
species infesting the same area and you don’t have time to map them 
individually.  Remember that if the extents of each species are not the same, this 
option should not be used.  For each additional species, you must also enter the 
phenology, percent cover, stem count, action, and control effort (see above) 
using additional fields provided. 
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2Action, 3Action… 
 
2Control_Effort, 
3Control_Effort… 
StartDate, 
StartTime 

Don’t worry about these fields, because the unit creates them automatically for 
each feature recorded. 

 
 
Table 4 – Description of generalized locations for field Location_Name. 

Park 
Unit 

LocationID Location Description In 
Park?

BELA serpentine_springs Serpentine Hot Springs and ATV trails radiating out from there yes 
CAKR dmts_rd road from Red Dog Mine to port yes 
CAKR kakagrak_hills abandoned military base and airstrip yes 
CAKR kotzebue Kotzebue and surroundings no 
DENA first_mile park road from the entrance at the Parks Highway to headquarters, 

including headquarters, housing, sled dog area, etc 
yes 

DENA kantishna inholdings at the end of the park road after Wonder Lake yes 
DENA mckinley_village development along Parks Highway outside the boundary no 
DENA nenana_river banks of the Nenana River no 
DENA park_rd park road between headquarters and Kantishna yes 
DENA parks_hwy Parks Highway along boundary no 
DENA railroad along railroad tracks, near depot, including airstrip yes 
DENA south_side_denali Denali south of the Alaska Range yes 
GAAR kuyuktuvuk Kuyuktuvuk watershed, including Oolah Pass yes 
GAAR noatak_river along Noatak River yes 
GLBA bartlett_cove frontcountry Glacier Bay, including lodge yes 
GLBA beardslees Beardslee Islands yes 
GLBA dry_bay Dry Bay and vicinity yes 
GLBA dundas_bay Dundas Bay and surrounding areas yes 
GLBA east_arm coastline of the East Arm of Glacier Bay yes 
GLBA glacier_bay_other Other areas of park not in Dry Bay, Dundas Bay, or main Glacier 

Bay 
yes 

GLBA gustavus Gustavus and surroundings no 
GLBA main_bay the portion of Glacier Bay to the south of the two arms yes 
GLBA west_arm coastline of the West Arm of Glacier Bay yes 
KATM 10000_smokes_rd entire road leading to the valley of 10000 smokes yes 
KATM brooks_camp brooks camp and surrounding area yes 
KATM katm_outer_coast anywhere along the katmai coastline yes 
KATM king_salmon King Salmon and surroundings no 
KATM lake_camp entire lake camp road, boat ramp area, and parking area yes 
KEFJ exit_glacier Exit Glacier Road and associated development and trails yes 
KEFJ kefj_outer_coast anywhere along the Kenai Fjords coastline yes 
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Park 
Unit 

LocationID Location Description In 
Park?

KEFJ seward Seward and surroundings no 
KLGO chilkoot_trail the Chilkoot Trail Unit yes 
KLGO dyea Dyea and surroundings yes 
KLGO dyea_road Road to Dyea and surrounding area not in park no 
KLGO klondike_hwy Klondike Highway above Skagway, except for White Pass Unit no 
KLGO skagway Skagway and surroundings no 
KLGO white_pass the White Pass Unit yes 
KLGO white_pass_railroad Railroad corridor outside of White Pass unit no 
LACL lacl_outer_coast anywhere along the outer coast of LACL yes 
LACL port_alsworth_nps NPS headquarters in port alsworth and surrounding areas yes 
LACL port_alsworth_town town of port alsworth and surrounding areas no 
LACL twin_lakes anywhere around twin lakes yes 
SITK sitka Sitka and surroundings no 
SITK sitka_park Sitka National Historic Park yes 
WRST chitina Chitina and surroundings no 
WRST copper_center Copper Center and surroundings no 
WRST copper_rvr along Copper River no 
WRST edgerton_highway Old and New Edgerton Highway from Richardson Highway to 

Chitina 
no 

WRST glenallen Glenallen and Glenn Highway no 
WRST kennicott Kennicott (Town and Mine Site), Bonanza Ridge and Root 

Glacier Trails 
yes 

WRST may_creek NPS compound, airstrip, and surrounding roads and trails yes 
WRST mccarthy McCarthy and surroundings yes 
WRST mccarthy_rd region from Copper River bridge to Kennicott River plus ATV 

trails 
yes 

WRST nabesna_rd Nabesna Road and ATV trails yes 
WRST remote_airstrip Peavine, Huberts, Tana, Jake's, C-N confluence, Chisana so far yes 
WRST richardson_highway Richardson Highway from Gakona Junction (north) to Edgerton 

Highway (south) , except for Copper Center 
no 

WRST slana area outside of the park at the entrance to the Nabesna Road no 
WRST tok_cut_off along Tok Cut-off from Slana to Gakona Junction no 
WRST viscenter headquarters and visitor center complex yes 
YUCH coal_creek coal creek camp and surrounding areas yes 
YUCH yukon_river along Yukon River yes 
 other DESCRIBE LOCATION IN COMMENTS  
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To visually see the delineation of each 
LocationID, refer to the “EPMT Location 
Index” theme in ArcGIS that can be loaded 
using NPS Theme Manager (Fig. 3). 
 
 
 
 
 
 
 
 
 
 
 

Table 5 – Description of the disturbance types for field Disturbance_Type. 
Disturbance Type Disturbance Description 

ABDHOME Abandoned Homesite 
ANIMAL Animal Related Disturbed Site 

BRSHCUT Mechanical Brush/Tree Cutting 
COASTAL Coastal/Beach 
FLIMPRT Fill Importation (e.g. Road or Railroad) 
GLACIER Glaciation 
GRAZING Grazing 
HRBCIDE Herbicide Application 
LOGGING Logging 
MATEXTR Material Extraction (e.g. Quarry) 

MINING Mining 
MOWING Mowing 
ORVDST ORV Disturbance 
OTHER Other Mechanical Substrate Alteration 

PLOWING Plowing 
RIVER River Action 
SLIDE Landslide/Avalanche 

STREAM Stream Action 
THERMAL Thermal Disturbance 
TRMPLNG Trampling 
VOLCANO Volcanic Action 

WIND Wind Disturbance/Erosion 
WLDFIRE Wildfire 

WNDTHRW Windthrow 
NONE No Disturbance 

 

 

Figure 3 – EPMT location index in Theme Manager.
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General Tips for Using the GPS 
 

1. While recording a feature, hold the unit head-high and away from your body, so that it 
can “see” more sky.  

2. The logging interval (how often the unit records a position within a feature) has been set 
in the data dictionary to one second for points and five seconds for lines and polygons.  
This is the desired interval; however, when satellite availability is marginal the 5 seconds 
may be too long to collect sufficient points.  In this situation, temporarily change the 
logging interval to 1 second 

1. While in the Data view (because you’re collecting a feature) tap “Options” 
2. Select “Logging Interval” and change the “Logging Interval” to “1s” 
3. When good satellite coverage resumes, readjust the interval to “5s” 

 We recommend recording at least 15 positions for points and enough positions for lines 
and polygons to delineate the shape (more around corners and curves, fewer for straight 
sections).  

 For the integrity of the data, it is a good idea to begin a new rover file every few hours 
rather than using the same one all day.  Also, make sure each event (different location, 
different crew, etc) is in a separate rover file. 

 Remember that you can always press “Pause” to stop the recording of positions 
temporarily while the feature is still open.  This is helpful if you have to maneuver 
around an object, but you do not want to map your deviation.  

 Stopping and resuming a feature.  If you are mapping a large area with multiple common 
species (such as a long road) and suddenly stumble upon an unusual species, you should 
map the unusual species more accurately then lumping it into the larger polygon.  In this 
case, stop the existing feature, map the specific feature, then resume the original feature. 

 If the new feature will be a point (including photo point or collection), 
then use the “Nest” option: 
1. Pause the feature you have been collecting. 
2. Within the data screen, select “Options” > “Nest” > and select 

appropriate feature type. 
3. Record the new feature. 
4. When you are complete and hit OK, you will return to the feature that 

you originally paused. 
 

 If the new feature will be a line or polygon, then stop, map the new one, 
and resume: 
1. In TerraSync, stop the current feature by clicking “OK.” 
2. Map the new feature. 
3. To resume the original feature, in the menu where you usually pick the 

feature type, switch “Collect” to “Update Features.” 
4. Select the feature you want to resume.  It is probably the second 

closest distance, and you will be able to see the comment along the 
bottom of the screen. 

5. Click “Begin” followed by “Log.” 
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6. Select “Continue Feature (Append)” to continue adding points to the 
original feature. 

7. End the feature like normal. 
8. To collect a new feature, you will need to change “Update” back to 

“Collect.” 
9. You will only be able to update recent features, so do not map multiple 

new features and plan to return to the original feature. 
 Turn on/off sounds when collecting positions 

1. On the Start Menu tap on “Settings” 
2. On the “Personal” tab, select “Sounds and Notifications” 
3. On the “Volume” tab, check “Programs” and “Notifications” and adjust the 

volume bar. 
 Offset feature.  In general, you should map the boundaries with buffer as exactly as 

possible; however, sometimes you will be unable to map an edge because of satellite 
coverage (e.g., under trees, next to a building) or physical barriers (e.g. river, fallen 
trees).  In these cases, you can map a set distance from the target and set the offset and 
direction.  The offset applies to the whole feature, so plan ahead! 

1. With the feature already open, select “Offset” from the “Options” menu.   
2. For a line or polygon, the direction is the direction the target is from you as you 

walk the segment.  The horizontal distance is the distance that you are from the 
target edge. 

3. For a point, you have 5 options: Distance-Bearing, Distance-Distance, Triple 
Distance, Bearing-Bearing, Triple Bearing.  See this QuickStart file for more 
information. 

 

Monitoring 
 
All control sites from previous years should be monitored and retreated this summer.  The 
reason for this is that we need to know what is working and what is not.  Beyond this, it is 
generally recommended for any exotic plant control that the site be monitored into the future, 
because there may still be a seedbank in the soil or plants may resprout.  For control sites where 
there are exotic plants present upon return, control the site again and plan to return within a 
month or so to evaluate the effectiveness.   
 

Loading Data Files 
 
A merge of all previous years’ data has been transformed into species specific data files for each 
park (example GLBA_BROINE.imp) for use on the GPS units.  Once transferred to your GPS 
unit using PFO, the data files can be used in one of two ways 
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Data file as background 
As a background, the polygons are visible on the “Map” screen, and you can collect features in a 
rover file, but the attribute information of the data file is not accessible.  You can load multiple 
background files, which would allow a background image plus several taxa. 

 Within TerraSync, select “Map” screen.  From the “Layers” menu, select “Background 
Files.”  Make sure the “Show Data Files” is selected.  Select the data file(s) to display. 

 The polygons are now loaded as a background image. 
 None of the attribute information is accessible, but you can navigate to the polygons and 

collect features in a rover file. 

 Data file as existing data file 
When the data file is loaded as an “Existing Data File”, the polygons are visible on the “Map” 
screen, and you can view the attribute information, but you can not collect new features or open 
other rover files. 

 Within TerraSync, select “Data” and “Existing.” 
 Highlight the appropriate taxon data file and select the “Open” button. 
 The data file is now open like a rover file, but you should not collect new features. 
 Under “Options” in either “Data” or “Map,” you can “Filter” the data.  For example, you 

could filter by park or by management action.  The filtered polygons will display as 
green. 

 From the “Data” screen you can see the distance to the nearest polygons. 
 Any polygon’s attributes can be opened by highlighting it in the “Data” screen and 

selecting “Begin.”  From the “Map” screen, you can select a polygon using the “Select” 
arrow from the upper left menu.  This will display the summary labels.  By selecting 
“Update Selected Feature” from the “Options” menu, you can then see all of the 
polygon’s attributes.  Do not log positions since this would change the data!!! 

 To collect new features, you must return to the “Data” screen, “Close” the data file, and 
reopen a rover file or begin a new rover file. 

 

Navigating to Previously Recorded Polygons 
 
Particularly when treating and monitoring previously documented sites, it is important to be able 
to relocate a site.  Using the “Map” screen is generally much easier than using the “Navigation” 
screen. 
 

Using Map screen 
With a data file loaded as either a background or existing data file, you will see the polygons 
relative to your position.  As you walk, your trail will display, and you will be able to modify 
your path to get to your target.  If this is not enough, you can set “Nav Start” and “Nav Target” 
through the “Options” menu.  “Nav Start” should be “GPS,” which is your current position (a 
single flag will appear).  Click on the screen where you want to go and then select “Nav Target” 
as “Map Point” (two crossed flags will appear).  The blue line connecting these two locations is 
the direct path.  Under “Options”, selecting “Cross-Track Light Bar” will display a bar at the top 
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of a map that will indicate the relative direction you need to go to get to the target (this only 
works when you are moving). 
 
Alternatively, you can set the “Nav Target” to the polygon desired if the data file has been 
opened in the Data screen.  By selecting the polygon, under “Options” you can then set the target 
as either the “Start/End” or generally better the “Centroid.” 

Using Navigation screen 
Set the “Nav Start” and “Nav Target” as described above.  The “Navigation” screen will display 
a number of variables of your position relative to the target, including distance, heading, bearing, 
etc. that are selectable by you.  The cross-track bar will display on the top as well to show 
relative direction of travel needed.  The central circle also shows the desired path.  Holding the 
GPS in front of you, the arrow within the circle points in the desired direction.  You need to be 
moving for the GPS to provide directional information. 
 

Restoration 
 
For parks engaged in restoration activities, a polygon feature should be collected to record the 
total number of person hours, what native species were added, and in what form the native plants 
were.  Additional fields for a revisit date and description of care/maintenance and survival rate 
are included, but they may be easier filled in after the fact in PFO. 
 
Table 6 – Description of attributes within feature Restoration. 
Location_Name This is the general area where the activity takes place with several possible in 

each park unit.  For a description of each area, see the LocationID table (Table 4).  
Note that a single LocationID must either be inside or outside of the park 
boundary; pay careful attention to this in choosing the appropriate one.  You 
should certainly arrange these in the order of your most common usage. 

Disturbance_Type Because most of Alaska’s exotic plants grow only on disturbed sites, we are 
tracking what disturbance types are being invaded by what species in NPS units.  
The options are listed in the Disturbance Type table (Table 5).  The most 
frequently applicable type is fill importation, which includes roadsides and 
construction sites.   

Site_Description The location description is an opportunity for you to delineate in words the exact 
location, as well as any information about that location that might be important.  
The first provision should enable someone who looks at a table of your data to 
understand where within the LocationID the work took place without having to 
use GIS.  Take the time while editing to be complete and also try to be concise.  
The second provision should note if there is special significance in the location, 
such as remoteness, proximity to a stream or river, or potential to be easily spread 
into other areas.   

Comments This is a free-for-all for you to convey anything that seems important about a 
restoration, such as purpose, what exotic species you are trying to prevent, 
suggested maintenance or additional restoration, etc.  use all lower case for 
consistency except for proper names. 

Park_Unit Associated park is the four-letter code for whatever park unit you’re working in, 
which should be set as the default value. 
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Is_Inside_Park If the area mapped is located on park land, enter “yes”; if it lies outside of the 
park boundary or on inholdings, enter “no”. 

Recorder_Name These are the initials of the person using the Trimble unit.  Set your initials as the 
default value. 

Team_Name If you are performing the activity in question alone or with help, enter 
“AKEPMT”.  If you are recording the accomplishment of volunteers, enter 
“Volunteer”, or of other NPS personnel, enter “Other”. 

Hours This is the total person hours (number of people multiplied by the number of 
hours) that were spent restoring the area. 

Native_taxon A text field to record the scientific name of the native species used during 
restoration. 

#_Planted Number of individuals planted.  If seeds, describe the volume or weight and 
clarify in the comments. 

Type Form of the native plant.  This is a list including cutting, fruit, individual, 
rhizome, runner, seed, seedling, stem, and transplant. 

2Native_taxon, 3 
Native_taxon … 
 
2#_Planted, 
3#_Planted … 
 
2Type, 3Type… 

Additional fields for 4 more native species used during restoration. 

Revisit_Date Date of site revisit.  This field is most likely to be filled out in the office using 
PFO after the initial polygon feature collection. 

Care_Maintenance Description of any care or maintenance that occurred at the site after the initial 
restoration.  This field is most likely to be filled out in the office using PFO after 
the initial polygon feature collection. 

Survival_Rate Description of the survival rate of the native plants added to the restoration area.  
This field is most likely to be filled out in the office using PFO after the initial 
polygon feature collection. 

 
 

Processing GPS Files in PFO 
 
All GPS data that you collect this summer will be processed using Pathfinder Office (PFO) 
software, Trimble’s desktop data management software.  At the beginning of the season, make 
sure the software is updated and that it will continually update by selecting the option in the help 
menu (Fig. 4).  Depending on your park’s computer settings, you may not be able to 
automatically update software.  Talk to your local IT staff for assistance. 
 



24  -  AK EPMT Protocol 2009 

Setting up a Project 
 

1. Open GPS Pathfinder Office (PFO). 
2. The first time you download GPS files for the season, create a new project for your 

park by selecting “New” 
3. Give the “Project Name” the title “2009_EPMT_(park code)” and browse to the 

…\Data\GPS\2009 folder for the “Project Folder.” 
 

 
 

4. Select “OK” 
5. Click “Yes” when it asks, “Folder already exists Do you want to continue?” 
6. Creating the new project creates 3 new folders within …\Data\GPS\2009 – Backup, 

Base, and Export.   
7. In Explorer, create one more folder (Final_Edits) within the project folder. 

Figure 4 – Enable Pathfinder Office to automatically update by 
selecting the option in the “Help” menu. 
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8. For the rest of the season, select the project name from the drop down menu that 
appears in the “Select Project” screen.   

 

Transferring Rover Files 
 

1. Transfer your rover files (.ssf) from the GPS unit to this folder as soon as possible 
after data collection. 

2. In PFO, select “Utilities” > “Data Transfer” 
 

 
 

3. Make sure the device is “GIS Datalogger on Windows CE” 
4. If Activesync has created a connection, the GPS should connect (status in upper right) 

automatically or when you click the button with the green circle with check mark. 
5. Click “Add” and “Data File” 
6. Select all the files needing to be transferred. 
7. Click “Transfer All.” 
8. Back up your rover files immediately in the project Backup folder.  

 

Differentially Correcting Rover Files 
 

1. In PFO, select “Differential Correction” from “Utilities.” 
2. Add the file that needs to be corrected.  To get the quality control values for the rover 

log spreadsheet, you need to process files individually. 
3. Verify the differential correction settings. 
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4. Select a base station.  Generally, you want to select the closest base station to where 

the data was collected.  Sometimes you may have to select a different base station.  
Update the base provider list periodically by selecting “Update List.”  Talk to 
Whitney, Joel Cusick, or other people locally at your park if there are questions about 
which base station to select. 

 



 

AK EPMT Protocol 2009  -  29 

5. Do not change any of the base station information or reference positions. 
 

 

 
 

6. Correct files by clicking “Start” 
7. Assuming good differential correction (ideally over 90%), fill out rover file status log 

using values that appear at the end of differential correction or that are saved in a text 
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file in the project folder (see image below).  This file is really, really important for 
Whitney to troubleshoot issues at the end of the season. 

 

 
 

8. If the file did not correct well: 
a. try other nearby base stations, 
b. wait a few days and try again (files being corrected against may become 

available), 
c. contact Whitney.  We may be able to download files manually.  Alternatively, the 

data collected may be sufficient without correction. 
9. Back up your .cor files immediately by copying them into the project Backup folder.  

 

Editing Files 
 
In order to ensure high data quality, review and edit every rover file within a few days of the data 
collection. 
 

1. Copy your corrected files from the project folder into the “Final_Edits” folder and 
add the prefix “edited_” to each file name.  For example, R051015A.cor becomes 
edited_R051015A.cor.  Copying and renaming the file before editing ensures that you 
do not overwrite the original corrected file when you begin editing. 

2. Check the validity of positions, once differentially corrected, to make sure they match 
what you recorded in the field.  Using a background image will help with this. 

3. For point features, click “Delete” in the Feature Properties window to see that the 
positions are a reasonably tight cluster.  The “Delete” does not delete your positions 
but it gets rid of the feature grouping the positions.  You may need to delete whacky 
points (using the “Delete” in the “Position Properties” window), such as points more 
than a few meters from the center of a point (when you inadvertently walked away 
while still collecting positions).  Once the feature looks good, you should click 
“Undelete” in the “Feature Properties” window to regroup the positions. 

4. For a line or polygon, you will need to delete positions that double back or cause 
loops in the feature.  Generally the positions with the highest value in “Horiz. 
Precision” should be deleted since they have the most likely error. 



 

5. Document position deletions in the rover log.   
6. If a feature was recorded as the wrong type (e.g. line collected as point), contact 

Whitney for assistance.   
7. Review the attributes attached to each features to check that the information is 

accurate and complete.  
8. Elaborate on location descriptions or comments and eliminate any bad data.  If you 

wrote in shorthand only understandable by you, now is the time to convert it to 
complete thoughts!  Your comments will be viewable by the public, so make them 
understandable and appropriate for ALL AUDIENCES.  Species can be abbreviated 
by using the first three letters of the genus and species.  For example, Leucanthemum 
vulgare would be leuvul. 

9. Take the necessary time to make your data as finished as possible.  These files will be 
transformed into GIS data at the end of the season for anyone to peruse.  Did you 
leave any fields blank?  Are all the attributes correct?  Do they make sense? 

10. In the project folder, maintain a status spreadsheet park_rover_file_status_2009.xls 
(save the spreadsheet locally with your park code as a prefix) to keep track of which 
files still need to be edited.  List any issues, deletions, deviations from the protocol, or 
field notes you had for each rover file. 

11. Copy the Final_Edits files into the project Backup folder. 
12. Periodically burn a CD of or otherwise backup the project folder and upload all raw, 

corrected, and edited rover files (.ssf, .cor, and edited.cor) and log to the 
2009_INCOMING folder at the end of every pay period. 

13. Once you have finished editing a file, you are done with it until the end of the season. 
14. Once all edited files are complete, let us know and we will transform them into GIS 

files to ensure consistency among park units and send them back to you for your 
reference in preparing the seasonal report. 

 
 

 

Whitney’s Editing Strategy – I think it’s most efficient to first look at the shapes of all the 
features and do the necessary deletions of positions to make the shapes true to life.  I’ll do this
for the entire cor file.  I then start at the beginning again and quickly flip through the features 
looking at the attributes for blank data fields (yes, even I sometimes forget to populate a 
field).  I populate the field if I can accurately recall what it should have been.  I then start at 
the beginning for the last time to carefully review the attribute information, replace any 
shorthand, and otherwise clarify comments.  This strategy works for me to assure the spatial 
and attribute data get the attention they both need.  
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Historic EPMT Data 
 
This protocol does not describe how to 
use ArcGIS; however, it does describe 
how to review all historic EPMT data for 
the entire region.  From NPS 
ThemeManager (Fig. 5), load either all of 
the regional data (Exotic Plant 
Management > Plant Surveys > EPMT 
Exotic Plant Surveys) or park specific 
data (Exotic Plant Management > By Park 
> (Park Code) Exotic Plant Surveys) by 
dragging the name into ArcMap.  
Information about the polygons can be 
found using “Identify” or selecting the 
polygons and looking at the “Attribute 
Table.”  Note: the themes may not work 
in earlier versions of ArcMap, so upgrade 
to ArcGIS 9.2. 
 
 
 
 
 
 
 
 

Time Log 
 
All of our data must be entered into a nationwide NPS database (APCAM – the lien Plant 
Control and Monitoring database) that requires very specific information about the amount of 
time spent and people involved in every activity we perform, not only in the field but also in the 
office.  
 
To ensure consistency between all the parks, Whitney will be doing all the data entry in 
APCAM.  In order for this to happen, however, we will require very specific information on the 
time you spend on individual activities on a daily basis from the moment you read this protocol 
until the last day you work for the EPMT in 2009.  We know that this seems extreme, but there is 
no other way to satisfy the database requirements and minimize database angst. 
 

1. Copy the spreadsheet park_time_record_2009.xls to your local folder and change 
“park” to your park’s acronym.  

2. At the end of each day, make a log of what happened.  

Figure 5 – Location of historic EPMT data in NPS 
Theme Manager. 
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3. Every line NEEDS to have a date, start time, and stop time.  Do not just assume the 
row above, etc. 

4. All work time activities should be accounted for, including: 
 Administrative Tasks 
 APCAM data entry 
 Budget/Finance 
 Control Work 
 Data Collection 
 Data Management 
 Education & Outreach Activities
 Equipment Maint/Repair 
 Formal Meetings Attended 
 GIS/GPS Work 
 Hiring Activities 
 Meeting 

 Misc Park Activities 
 NEPA related 
 Partnership development 
 Personnel Management 
 Prepare for training/travel 
 Presentation Preparation 
 Project Planning 
 Report Writing 
 Restoration 
 Time Lost Due to Injury 
 Training 
 Travel 

 
  

5. The bold categories are super critical to get accurate: number of people, time, and 
location id. 

6. If the activity is associated with a GPS rover file, record those file(s) in your time log. 
7. Each person routinely associated with the EPMT should account for their activities on 

an individual line.  So, even if Whitney and Jeff are both controlling oxeye daisies 
from 10:00 to 12:00, there should be two lines with each of their initials.  If people 
not usually associated with EPMT work are assisting, they can be accounted for them 
in the “Number of other people” field and then describe who they are in the 
description.  Alternatively, each EPMT team member can keep their own log. 

8. Alternatively, each EPMT person at a park should maintain their own log with one 
person ensuring that others/volunteers are accounted for consistently. 

9. Locations, initials, etc can be modified by adding/deleting values from the “Pull-
down menus” worksheet. 

10. All grey fields will automatically calculate.  Do not modify the formulas.  If the hours 
is negative, then the times are entered wrong (PM is in 24-hr time).  If the grey fields 
do not display values, then talk to Whitney. 

11. As with all important files, back this one up on a regular basis. 
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Table 7 - An example of a 1-day trip in GLBA with two EPMT staff and another NPS employee.  The 
fields shaded gray are automatically calculated. 

Day 
of 

Week Date
Time 
Start

Time 
End

Activity 
Category Location Park

Activity 
Description

Rover File 
Associated 
with Activity

Weight 
(lb)

EPMT 
Person 
Initials

Number 
of other 

NPS 
staff

Number 
of 

voluntee
rs

Number 
of other 
people

Total 
People Hours

Total 
People 
Hours

Mon 6/2/2008 8:00 10:00
Prep & 

Cleanup Office GLBA
Prepare for field 
work WSR 1 2 2.00 4.00

Mon 6/2/2008 10:00 11:00 Travel Travel GLBA
Skiff to Strawberry 
Island WSR 1 2 1.00 2.00

Mon 6/2/2008 11:00 15:30
Control 
Work main_bay GLBA

control perennial 
sowthistle R060215a 35 WSR 1 2 4.50 9.00

Mon 6/2/2008 15:30 16:30 Travel Travel GLBA Return to BC WSR 1 2 1.00 2.00

Mon 6/2/2008 9:00 10:00
Prep & 

Cleanup Office GLBA
Prepare for field 
work JAH 1 1.00 1.00

Mon 6/2/2008 10:00 11:00 Travel Travel GLBA
Skiff to Strawberry 
Island JAH 1 1.00 1.00

Mon 6/2/2008 11:00 15:30
Control 
Work main_bay GLBA

control perennial 
sowthistle JAH 1 4.50 4.50

Mon 6/2/2008 15:30 16:30 Travel Travel GLBA Return to BC JAH 1 1.00 1.00

Mon 6/2/2008 16:30 17:00
Prep & 

Cleanup Office GLBA clean-up field gear JAH 1 0.50 0.50  
 

Photo Management 
 
*** All photo data must be edited and uploaded to the regional drive by the end of every 
pay period (every 2 weeks).  This will ensure that the data is being processed correctly and 
timely on your part and that Whitney can process it into the national databases and make the data 
available for use. 
 
Photos are an excellent tool for exotic plant management, not only to document infestations and 
sites for our own internal purposes, but also to convey to others what we are dealing with and 
what we have accomplished.  Several excellent photo opportunities include: 

 Before and after photos of infestations that are controlled 
 Volunteer events – work in action 
 New or uncertain species, range expansions, or particularly nasty infestations 
 Close-ups of particular species to aid in identification 
 Restored plant communities 
 Educational events 
 Yourselves and others working with exotic plants 

 
You should be taking photos essentially everytime you are outside!  That said, we can only 
use these photos later on if we keep them organized and collect relevant information about them.  
 

Taking Photos 
Use the GPS “Photo_pt” feature that will later be coupled with GPS-Photo Link by Whitney to 
bring the photo together with the position and attribute information. 
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Before taking photos: 
 Set the camera’s clock to be as close to 

the GPS clock as possible (8 hours less 
than UTC time during AK daylight 
savings).  Recheck at least monthly!!! 

 Resolution should be as high as 
reasonable given memory constraints, 
with the preferred filesize (for a .jpg) 
being greater than 1 MB per photo.  

 Before you take your first picture of the 
day, take a picture of your GPS screen 
showing the time with seconds.  This is 
critical for the GPS-Photo Link software.  
Within TerraSync Status>UTC Time 
(Fig. 6) has the time.  Verify the image is 
legible.  Several photos are better than 
one that is unclear.  Be aware that the 
screen is very reflective and not easy to 
take a good picture of clearly.  Holding 
the GPS at an arms length or using the 
macro (flower) setting when the GPS is 
closer may also improve the focus. 

 
When taking photos: 

 Before you take the photo, collect a 
“Photo_Pt” feature using your Trimble 
unit at the spot where you are standing 
when taking the photo.  

 After the Photo_Pt is collected, take your photo(s) of the same scene.  If the subject of 
the photo changes such that your description is no longer valid or your position changes, 
you need to record a new Photo_Pt before taking the next photo. 

 
Table 8 – Description of attributes within Photo_Pt feature on GPS. 
Photographer Initials from drop down menu 
Location_Name Standard locations from drop down menu 
Comments Short description/title of image.  Such as “Visitor Center dandelions.”  This 

description will later be watermarked onto the image with GPS-Photo Link. 
Internal Longer description/comment.  Such as, “Area will be treated next week.”  This 

comment will be embedded in attributes and not displayed on image.  Record more 
specific location/event information here.  This is what will give lasting value to the 
image!  

LookDir Direction you are facing to take the image. 
Filename Record image number/file name.  This may be feasible in the field or easier to do as 

you edit images in PFO. 
 
 

Figure 6 – Screen shot of GeoXT showing 
UTC time with seconds.  Alaska daylight 
savings time is 8 hours less.  This screen is 
essential for linking to the photo time for GPS-
Photo Link. 
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Managing Photos 
We recommend that you manage your photos – meaning upload, organize, and delete useless 
photos – at the same time that you are editing your spatial data in Pathfinder Office. 
 

 Maintain subfolders by event, such as 20090613_Weed_Pull, that will help you and us 
locate a photo. 

 Step through the “Photo_pt” features in Pathfinder Office with an image browser window 
open at the same time and ensure that the attribute information is complete.  If 
incomplete, modify the attributes to be accurate.  Ensure that the image name is in the 
Filename field. 

 Delete any photos that are unusable – blurry, too dark/light, etc. 
 If there are images that do not have Photo_Pt features, modify the filename by putting a 

“z” at the beginning of the filename to flag us not to link it to a position. 
 Always keep the original, unmodified, unedited images.  DO NOT rotate, resize, 

brighten, or darken any original photo since you risk losing all data collection time 
embedded in the photo.  If you want to edit an image, resave it with another name, such 
as [original filename]_edited. 

 At the end of every pay period, transfer all photos you have to the regional drive. 
 Whitney will process the photos using GPS-PhotoLink and the data collected with your 

Trimble, such as the example (Fig. 7) 
 
 

Figure 7 – How an image taken after a Photo_Pt can be combined 
in GPS-Photo Link to incorporate the position and field comment.  
A shapefile is also generated that contains the additional attribute 
information. 
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Two “money” shots from each park are needed this year.  Examples of great pictures are 
those that tell a story about the work that we do and show the majesty of the place.  Think 
about the background and the subject.  Getting NPS uniforms and arrowheads in the shot 
helps.  These will take some time and likely some staging.  Here are two great examples from 
the past.  
 

 
 
 

Voucher Specimens 
 

What to Collect 
 
In order to back up our observations of plants in the field, voucher specimens should be collected 
under certain circumstances:  
• Any species previously unrecorded in a park unit should be collected. 
• Any species that you cannot positively identify should be collected following 
consultation with others to ensure it is not rare.  Photos and a GPS point can be a good interim 
measure to help id the species, particularly if there are few specimens. 
• Any species with a significant range expansion or found in remote areas should be 
collected, with priority given to species of greater concern. 
 
In 2009, make an effort to fully collect all specimens previously reported but not collected.  
Refer to the table AK_EPMT_Master_Exotics.xls for a list of all the species reported for each 
park with a column for when the plant was collected.  Data for collection years before 2005 were 
taken from the I&M database NPSpecies and may need verification with your park herbarium.  
Let Whitney Rapp know of any changes needed to this spreadsheet.  Verify that you have the 
necessary permission to collect within your park. 
 

mailto:Whitney_Rapp@nps.gov
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How to Collect 
 
1) A photo should be taken of the whole plant prior to collection following the photo protocol. 
2) A GPS “Specimen_Pt” should be recorded to account for as many fields as possible. 
 
Specimen_Pt fields on GPS 
 
Collection_Date Date specimen collected 
Collector_Name Initials of collector 
Taxon Scientific name of species if known 
Park_Unit Park abbreviation 
Location_Name Standard locations from each park 
Specific_Locality Field to make more specific description of location 
Habitat Field to make more specific habitat description 
Soil_Texture clay, silt, sand, loam, gravel, or other – see table below for descriptions 
Soil_Moisture dry, moist, wet, or other 
Exposure N, NE, E, SE, S, SW, W, NW 
Slope_Site flat, gentle, steep, other 
Species_Abundance rare, infrequent, common, abundant, other 
Assoc_Spp Field to enter other nearby native and non-native species 
Notes Any additional notes or clarification on fields 
Photographed? Yes/No – All specimens SHOULD be photographed 
Collnum *Collection number.  Initials followed by number.  e.g. WSR001 
Photo_filename *Filename of specimen photo 
Determiner *Person who identified the specimen 
Determiner_Date *Date determiner identified the specimen 
NPS_Accession *NPS accession number 
NPS_Catalog *NPS catalog number 
Native *Nativity of specimen – Yes, No, or Unk 
Collection_number *Identifying number of specimen (initials followed by number) 
* these fields are likely best populated in the office in PFO. 
 
3) Collect the specimen.  All parts of the plant should be represented, including roots and 

flowers or fruits, and should be preserved using a plant press or heavy books with newspaper.  
Each species should be dried within newspaper and labeled with the information below or a 
unique collection number (initials followed by a number – WSR001, WSR002) that relates 
back to the master table. 

 
Review the University of Alaska Museum’s collection recommendations 
(http://www.uaf.edu/museum/collections/herb/projects/reports/instructions-for-plant-co/).   
 
Information about the specimen collected should be recorded in the spreadsheet (park 
ID)_Collections_2009.xls.  It may not be feasible to record all fields, but an effort should be 
made to populate as many fields as possible.  Fields in bold in the table below are required.  Use 
the “Specimen_Pt” data collected on your GPS. 
 
 

http://www.uaf.edu/museum/collections/herb/projects/reports/instructions-for-plant-co/
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Collnum Initials followed by number.  e.g. WSR001 
Park Four letter park acronym.  e.g. GLBA, DENA 
Scientific Name Best identification possible.  AKNHP will verify all identifications and modify as 

necessary. 
General Locality General location of specimen.  e.g. Parks Highway or Bartlett Cove. 
Specific Locality Specific location of specimen.  e.g. 1.5 miles from park boundary on east side of 

road. 
Lat (DD) Latitude in decimal degrees.  e.g. 59.68595 
Long (DD) Longitude in decimal degrees.  e.g. -135.56987 
GPS/Map Source of lat/long - from GPS or calculated from map. 
Map Datum Map datum used for lat/ long (NAD27, 83 etc). 
Elev Elevation of collection. 
Elev unit ft or m 
Habitat Describe habitat.  e.g. roadside, coastal meadow, riparian, spruce forest 
Soil Texture Soil texture.  Clay = smallest particle size (<3.9 µm – not gritty in your mouth); a 

marble-sized hunk rolled between your fingers will form a ball.  Silt = small 
particles (3.9-62.5 µm – will feel gritty in mouth); a marble-sized hunk rolled 
between your fingers may form a ball.  Sand = larger particle size (0.0625 mm -2 
mm); a marble-sized hunk rolled between your fingers will not form a ball.  Loam 
= relatively even concentration of sand, silt, and clay; a marble-sized hunk rolled 
between your fingers will seem to form a ball, but it will fall apart once pressure 
is released.  Gravel = largest particles (2-75 mm) 

Soil Moisture Soil moisture (wet, moist, dy, other) 
Exposure Which way the site faces (N, S, E, W, etc) 
Slope Angle of site (flat, gentle, steep) 
Abundance Relative abundance of species at location (abundant, common, infrequent, rare) 
Assoc. spp. Other native or non-native species growing in the area. 
Collector(s) Enter as: Heys, J. 

Enter multiple collectors separated by commas with “&” before the last collector: 
Heys, J. & Rapp, W. 

Collection Date full date (6/25/2006) 
Determiner Person who identified specimen. 
Det Date Date specimen was identified (9/27/2006). 
Photo# Name of digital image or full path to image. 
NPS Accession # Generally, the entire set of specimens will receive the same accession number 

from the park's curator. 
NPS Catalog # Each specimen will get a unique number from the park's curator.  If 3 common 

dandelions are collected, make 3 separate rows, each with its own catalog #. 
Notes Any other taxonomic or collection notes/comments, such as flower color (some 

blossoms fade with drying, some colors intensify), odor, conspicuous use by 
animals, specimen looks like a hybrid or doesn’t match descriptions, etc. 

 
At the end of the season: 

1. Obtain the accession number and catalog numbers from your park’s collections 
curator. 

2. Verify that each specimen is identified by at least its Collection Number. 
3. Communicate with Whitney at the end of the season about sending specimens for 

mounting or mounting and labeling specimens locally. 
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4. Ensure the table (park ID)_Collections_2009.xls is transferred to your park’s 
incoming folder within the regional folder. 

 

Phenology Log 
 
Throughout the season, record when exotic species first flower and first set seed using the 
park_Phenology_2009.xls spreadsheet (save the spreadsheet locally with your park code as a 
prefix).  It may be easiest to print out the sheet and routinely write down the dates throughout the 
season.  Then, enter the information into the spreadsheet.  If you visit several park areas 
periodically that you suspect have different phenologies, record dates on separate sheets for these 
different locations.  Printing this spreadsheet on weather resistant paper and storing it in the GPS 
pouch serves two purposes.  Not only will you have it in the field to record dates, but if you 
space out on the name of a species to record in the GPS, the sheet may trigger your memory 
since it has common names! 
 

Seasonal Report 
 
The seasonal report for your park is your chance to summarize what you’ve learned and 
accomplished with regard to exotic plant management.  These are immensely valuable for 
record-keeping and future planning, and it will also demonstrate to your supervisor the quality of 
your work.  There is no page limit for this, because it is more important that you get across what 
you did and found this summer, no matter the length.  Be as thorough as possible with this.  Feel 
free to borrow from previous years rather than recreating the wheel.  The best reports build on 
the information from previous years! 
 

Items to be covered in the report: 
 Abstract/Executive Summary – a succinct summary of the season that could include total 

number of species inside/outside of park, areas surveyed, new species found, species 
eradicated, acres inventoried/infested/treated, etc.  This may be your only opportunity to 
inform someone! 

 Introduction - you do not need to provide an overview of why invasive plants are a 
problem for Alaska.  Instead, focus on your park unit's history of exotic plant surveys and 
management efforts - the context of your work in 2009 

 Methods - explain how you chose where to survey, where you surveyed, how 
thoroughly/frequently you surveyed each area, and what control methods and personnel 
you used, but don't go into detail about the data collection protocol (cite that you 
followed this protocol). 

 Results – this should be the focus of your report.  Let the reader know what you found 
and did, so that the data does not have to speak for itself.  Include: 

• Accomplishments (Prevention, Detection, Inventory, Control, Monitoring, 
Restoration, Education, Contacts, etc.) – use your time log to remind yourself 
of all the activities you have been involved in 
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• Summarize 2009 exotic plant distribution (diversity and relative species 
abundance in frontcountry and backcountry) in comparison to what you know 
of results from previous years.  Highlight any new species or situations of 
particular concern.  Are there eradicated populations?  Are any species 
colonizing natural areas? Let us know! 

• Include a table that includes all the invasive species documented in and 
around your park at any time.  This should be the list from 
AK_EPMT_Master_Exotics_2009.xls and any additional species documented 
in 2009.  If there are species on our master list that you do not believe should 
be there, let us know.  Include in this table if you observed it in 2009 and what 
parts of the park it was seen (e.g. Park Headquarters, Park Road, Backcountry, 
Outside Park).  If the species has been eradicated, include it in the list but 
indicate that when it was last observed. 

 Discussion and Recommendations  - Make recommendations for next year to improve 
how things can be done at your park or regionwide.  Be thorough with everything that 
could be done, even if it seems unlikely to happen.  Also include anything else you think 
is important! You've spent a summer working with and thinking about this issue, so offer 
your perceptions, concerns, ideas, problems, etc. 

 
Use the common and scientific names that appear in the master exotics table so that they are 
consistent throughout your report and the region.  Common names should not be capitalized 
unless they have a proper name (eg. European mountain-ash and common dandelion).  Scientific 
names should have the genus capitalized  and be italicized with the exception of abbreviations 
used (eg. Taraxacum officinale ssp. officinale and Melilotus spp.) 
 
Maps are optional.  If you would like to make maps in GIS with the 2009 data, let Whitney know 
by September 1 so the data can be transformed to a shapefile. 
 
As far as timing goes, the data processing must be complete by Sept. 1 at the latest and 
preferably earlier so that we can troubleshoot any problems or inconsistencies that arise.  
Determine who at your park should review the document.  Draft reports should be sent to EPMT 
regional staff at least two weeks prior to your end date or Sept. 15th (whichever is earlier) for 
review.  If that presents a problem, let us know.  In any event, if you have any questions or 
issues, give us a call or email.   
 
Look at reports from all parks and years for ideas on form and content to improve your report!   
 
Although not required, the NPS report templates may be used - 
http://www.nature.nps.gov/publications/NRPM/index.cfm#Templates. 
 
The Editorial Style Guide for Park Science and Natural Resources Year in Review is another 
refernce for writing NPS reports - https://science1.nature.nps.gov/naturebib/biodiversity/2007-6-
5/Editorial_Style_Guide.pdf 
 
Please provide at least a version in MS Word.  Acrobat PDF versions can also be made if they 
are compatible with version 5.0 or later. 

http://www.nature.nps.gov/publications/NRPM/index.cfm#Templates
https://science1.nature.nps.gov/naturebib/biodiversity/2007-6-5/Editorial_Style_Guide.pdf
https://science1.nature.nps.gov/naturebib/biodiversity/2007-6-5/Editorial_Style_Guide.pdf
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Thank you for your participation this summer!! Please give Whitney any suggestions about how 
we can improve this protocol and the program.  We hope that you are interested in continuing to 
work with the Alaska Exotic Plant Management Team in the future. 
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Table of invasive species mapped in and around Alaska NPS units through 2008 
 
Taxon Common_name Ranking CAKR DENA GLBA KATM KEFJ KLGO LACL SITK WRST YUCH Total 

Acres
Total 
Parks

Aegopodium podagraria bishop's goutweed (blank) 0.159 0.783 0.942 2
Allium schoenoprasum wild chive (blank) 39.971 1.176 41.147 2
Alopecurus pratensis meadow foxtail (blank) 0.023 0.023 1
Amaranthus retroflexus pigweed (blank) 0.078 0.078 1
Aquilegia columbine (blank) 0.000 0.000 1
Arabis glabra tower rockcress (blank) 0.000 0.000 1
Arctium minus common burdock (blank) 0.000 0.000 1
Brassica rapa field mustard (blank) 0.466 0.000 0.466 2
Bromus inermis smooth brome grass 62 0.590 12.978 1.482 0.081 196.026 0.056 211.214 6
Campanula medium Canterberry bells (blank) 0.000 0.000 1
Capsella bursa-pastoris shepherd’s purse 40 1.579 0.785 3.711 0.692 0.078 0.318 3.426 10.589 7
Caragana arborescens Siberian peashrub 66 0.026 0.026 1
Centaurea montana perennial cornflower (blank) 0.318 0.226 0.544 2
Cerastium fontanum mouse-ear chickweed 36 343.933 1.639 3.343 348.916 3
Cerastium tomentosum snow in summer (blank) 0.110 0.110 1
Chenopodium album common lambsquarters 37 3.671 1.223 11.158 0.456 2.640 4.799 23.947 6
Cirsium arvense Canada thistle 76 0.815 0.815 1
Crepis tectorum narrowleaf hawksbeard 54 14.957 0.003 0.029 4.597 2.374 0.056 22.017 6
Dactylis glomerata orchard grass 53 0.146 0.146 1
Descurainia sophia flixweed 41 0.000 0.272 0.772 1.044 3
Digitalis purpurea foxglove 51 0.592 0.592 1
Elymus repens quackgrass 59 3.656 0.822 193.992 0.012 198.483 4
Erysimum cheiranthoides wormseed mustard (blank) 3.102 0.143 0.000 3.245 3
Euphrasia nemorosa common eyebright (blank) 1.521 1.521 1
Galeopsis bifida hempnettle 40 0.198 0.198 1
Galeopsis tetrahit hempnettle 40 0.001 0.268 0.003 0.271 3
Hieracium aurantiacum orange hawkweed 79 0.276 0.276 1
Hordeum jubatum foxtail barley 63 2.702 0.036 0.000 1.190 7.929 11.857 5
Hypochaeris radicata hairy cat's ear (blank) 4.945 4.945 1
Impatiens glandulifera ornamental jewelweed 82 0.049 0.049 1
Lamium album white deadnettle (blank) 0.009 0.009 1
Lappula squarrosa European stickseed 44 0.049 2.277 2.326 2
Lepidium densiflorum common pepperweed 25 0.532 0.081 1.901 2.515 3
Leucanthemum vulgare oxeye daisy 61 0.378 14.470 0.020 0.027 0.972 0.175 1.466 194.817 212.325 8
Linaria vulgaris yellow toadflax 69 1.085 0.069 0.108 6.437 0.153 193.948 201.800 6
Lolium perenne perennial ryegrass 41 11.885 11.885 1
Lupinus polyphyllus bigleaf lupine 55 0.024 388.116 0.056 388.196 3
Lychnis chalcedonica maltesecross (blank) 0.000 0.000 1  
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Taxon Common_name Ranking CAKR DENA GLBA KATM KEFJ KLGO LACL SITK WRST YUCH Total 
Acres

Total 
Parks

Matricaria discoidea pineapple weed 32 0.000 4.573 32.299 11.896 0.147 3.065 17.555 0.569 344.457 19.955 434.517 10
Medicago lupulina black medic 48 0.034 0.034 1
Melilotus alba white sweetclover 81 4.651 12.859 35.554 53.064 3
Melilotus officinalis yellow sweetclover 69 0.366 0.480 0.045 0.891 3
Mentha mint (blank) 0.003 0.003 1
Myosotis asiatica alpine forget-me-not (blank) 0.021 0.022 0.044 2
Myosotis scorpioides true forget-me-not (blank) 0.135 0.301 0.436 2
Papaver nudicale Icelandic poppy (blank) 0.000 0.000 1
Papaver somniferum opium poppy (blank) 0.000 0.000 1
Phalaris arundinacea reed canarygrass 83 5.984 0.030 1.167 7.181 3
Phleum pratense common timothy 56 0.484 50.187 0.125 2.159 0.078 1.226 0.511 54.771 7
Plantago major common plantain 44 8.846 315.433 1.717 1.012 6.622 7.144 4.230 374.910 52.603 772.517 9
Poa annua annual bluegrass 46 6.057 0.985 7.042 2
Poa pratensis Kentucky bluegrass 52 0.007 0.129 0.021 0.157 3
Polygonum aviculare prostrate knotweed 45 0.537 0.032 0.040 2.056 0.078 194.048 4.171 200.961 7
Polygonum convolvulus black bindweed 50 0.466 0.003 0.469 2
Polygonum cuspidatum Japanese knotweed 87 0.000 0.183 0.183 2
Prunus avium sweet cherry (blank) 0.268 0.268 1
Ranunculus acris tall buttercup 54 0.122 0.000 2.124 2.825 5.072 4
Ranunculus repens creeping buttercup 54 0.000 2.684 0.542 15.564 18.790 4
Rheum rhabarbarum rhubarb (blank) 0.778 0.029 0.807 2
Rosa rugosa rugosa rose (blank) 0.254 0.028 0.281 2
Rubus idaeus red raspberry (blank) 3.605 3.605 1
Rumex acetosella common sheep sorrel 51 0.696 1.431 0.018 11.557 0.081 0.318 0.359 14.461 7
Rumex crispus curled dock 48 0.000 0.143 1.138 1.282 3
Sagina procumbens birdseye pearlwort (blank) 0.216 0.216 1
Senecio sylvaticus woodland ragwort (blank) 0.000 0.000 1
Senecio vulgaris common groundsel 36 0.198 0.198 1
Silene latifolia bladder campion 42 0.000 0.000 1
Silene noctiflora night-blooming cockle 42 0.466 0.198 0.078 0.743 3
Silene vulgaris bladder campion 42 0.143 0.143 1
Sonchus arvensis perennial sowthistle 73 2.421 0.000 2.421 2
Sonchus oleraceus annual sowthistle (blank) 0.000 0.000 1
Sorbus aucuparia European mountain-ash 59 2.930 10.205 13.135 2
Spergula arvensis corn spurry 32 0.466 0.466 1
Stellaria media common chickweed 42 0.727 1.964 0.341 5.540 0.006 2.353 10.931 6
Symphytum officinale common comfrey (blank) 1.987 1.987 1
Tanacetum vulgare common tansy 57 0.044 0.003 0.047 2
Taraxacum officinale ssp. 
officinale common dandelion 58 0.000 58.128 869.418 6.100 12.891 64.533 10.447 10.191 241.298 17.436 1290.442 10

Thlaspi arvense field pennycress (blank) 0.000 0.001 0.001 2  
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Taxon Common_name Ranking CAKR DENA GLBA KATM KEFJ KLGO LACL SITK WRST YUCH Total 
Acres

Total 
Parks

Trifolium hybridum alsike clover 57 0.723 0.001 0.199 0.154 211.145 7.753 219.974 6
Trifolium pratense red clover 53 0.538 14.165 0.000 2.709 1.348 0.401 19.162 6
Trifolium repens white clover 59 3.883 143.395 0.000 0.305 21.571 1.392 5.620 207.847 384.013 8
Tripleurospermum maritima false mayweed (blank) 0.000 0.000 1
Tripleurospermum perforata scentless false mayweed 48 2.069 0.014 2.083 2
Triticum aestivum common wheat (blank) 0.043 22.833 22.876 2
Veronica serpyllifolia thyme-leaf speedwell (blank) 0.006 0.006 1
Vicia cracca bird vetch 73 0.018 0.033 2.366 2.418 3
Viola tricolor Johnny-jump-up violet (blank) 0.015 0.015 1

Total 
Acres 0.000 116.550 2300.690 24.918 15.343 152.460 55.061 61.789 2407.950 115.866 5250.626

Total 
Species 0 7 6 1 3 4 1 2 5 1 9

 


